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1. Giới thi ệu chương trình PCI  PABX 

 
Hiện nay các tổng đài PABX cho các khách sạn và các office không còn là một 
hệ thống hoạt động đơn lẻ , cũng như không chỉ đơn thuần phục vụ gọi đi,gọi 
đến mà còn có nhiều tính năng, dịch vụ tiện lợi khác. 
 
Các dịch vụ này sẽ phát huy mạnh mẽ khi được kết nối với mạng vi tính của 
khách sạn , office. 

 
 

 Serial/TCPIP/FTP   LAN 
 
 

 
PMS (Host computer)       

                                                   
 PABX          CDR(Data calling)              PCI   PABX                             HOST 
             
 
                                      Serial                           Serial/Paralel            COMPUTER 
   
                             
       
 
 
 
           PABX  : các loại tổng đài Acatel,Philip sopho,NT SL-1,AT&T,Siement 
                          Nisuko,Opus,Panasonic,Ky, Erisson,  v.v.... 
           Host computer : Novell , Windows, v.v.... 
           PMS     : Property Management System 
           Journal printer : in tức thời thông tin cuộc gọi CDR ( call detail recording) 
                        (thông tin nguyên thủy chưa xữ lý để dự phòng). 
           Voucher printer : Thông tin một cuộc gọi đã tính tiền và công nhận. 
 

 
PCI PABX 

Voucher 
printer 

Journal 
printer 
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2. Tính năng chương trình : 
 

- Hệ thống nhận số từ cổng COM, TCP/IP, File, FTP của tổng đài, các thông tin 
của cuộc gọi như máy chủ gọi, ngày giờ gọi, số máy bị gọi, thời gian nói 
chuyện, account code nhận được từ tổng đài sẽ được dùng để tính cước điện 
thoại và được lưu trử trên máy tính. 

- Data được lưu tới đĩa local và lưu trên máy server. 
- Quản lý giá cước điện thoại của VNPT, 171,178,179,177…. theo loại gọi 

(đường dài, quốc tế, di động, dịch vụ,…), theo vùng cước. Giá vừa tiền Việt 
vừa ngoại tệ. Có thể khai báo thêm, điều chỉnh giá, tăng giá theo phần trăm 
của từng loại gọi cho các nhóm máy (4 nhóm). 

- Tính lại cước khi sửa đổi giá cước trể. 
- In các báo cáo, các hoá đơn cho từng máy hay nhóm máy theo một khoản thời 

gian mong muốn. Số liệu có thể kết xuất ra file HTML, EXEL, DBF. Tiền 
cước sẽ qui về tiền Việt. 

- Phân bổ cước hàng tháng cho mỗi extentions. 
- In báo cáo theo trung kế, theo account, truy tìm số máy bị gọi. 
- Quản lý danh bạ các máy nội bộ trong tổng đài. Khai báo account code. 
- Lưu trử các số liệu thô của tổng đài, nhập số liệu cước từ file cước thô. 
- Kiểm tra Online data từ tổng đài. 
- Các cột số liệu có thể cài đặt lại. 
- Tỉ giá ngoại tệ. 
- Có kết nối với hệ thống mail để báo cáo tự động qua mail. 
- Bảo mật :Có bốn mức truy nhập hệ thống bắng password, phân quyền khai 

thác chương trình. 
- Phần mềm dùng đồng thời tiếng Anh và tiếng Việt. 
- Các chức năng dùng bằng menu hay phím tắt. 
- Có thể chạy chung phần mềm cùng các software khác trên một máy. 
- Chương trình có thể chạy trên Win9X, Windows 2000, Windows NT,… 

 
 
 



 Tài liệu hướng dẫn chương trình CDR 
Version : 18.0 
Ngày : 01/10/2010 

 

Trang : 7 

3. Màn hình chinh: 
 

3.1. Màn hình chính (Anh): 
 
 

 
 

3.2. Màn hình chính (Việt): 
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4. Bảng giá cước : 
 

 
 
 

4.1. Phương pháp tính cước cuộc gọi: 
 

• Số liệu nhận được từ tổng đài : ngày gọi, giờ gọi, thời gian nói chuyện, số chủ 
gọi, số bị gọi, mã authority. 

• Từ số bị gọi, bảng nhà khai thác   và bảng giá hướng gọi sẽ tìm được nơi đến, 
nhà khai thác được dùng, và từ ngày gọi sẽ tìm được  vùng cước tuỳ theo loại 
ngày (lễ, chủ nhật, ngày thường) và loại gọi. 

• Từ bảng vùng cước và thời gian nói chuyện, cước cuộc gọi sẽ tính như sau : 
 

Tổng giây  = giờ x 3600 + phút * 60+giây 
Giá P&T = giá đơn vị đầu  
if  tổng giây > đơn vị thời gian đầu 

Giá P&T = giá P&T + ((tổng giây - đơn vị thời gian đầu)/đơn vị thời 
gian kế) x giá đơn vị kế 

    if MODULA(tổng giây -đơn vị thời gian đầu,đơn vị thời gian kế) <> 0 
giá P&T = giá P&T +  giá đơn vị kế 

    endif 
endif  
 

• Ghi dữ liệu vào mẫu tin mới 
• Từ mã authority (nếu có dùng) và danh bạ điện thoại sẽ tìm được tên người 

gọi, số điện thoại của mã authority, nhóm tăng giá. Ghi tên và số điện thoại của 
mã authority tới mẫu tin. 

• Nếu bạn không sử dụng mãauthority, từ số chủ gọi và danh bạ điện thoại sẽ 
được tên người gọi, nhóm tăng giá. Ghi tới mẫu tin. 

• Từ loại gọi in bảng loại gọi   và nhóm tăng giá sẽ tìm được cột tăng giá ( có 4 
nhóm tăng giá), Từ đây TAX = giá P&T x tăng giá(%) 

• Từ thông số VAT(%), bạn có VAT 
VAT = (giá P&T + TAX) x Vat(%) 

• Tổng cước gọi: 
Cước gọi = giá P&T + TAX + VAT 

• Ghi tới mẩu tin 
 

4.2. Bảng hướng gọi: 
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Tên cột : 
- Hướng gọi : 10 số 

• Ví dụ : 078,0781,001,00123 v.v... 
- Nơi đến : Tỉnh, nước gọi đến 
- Loại gọi : Loại của cuộc gọi 
- Hướng/loại :       * Xem : vào mã số gọi để tìm (bao gồm prefix code) 
- Sửa và thêm : Vào mã mới hay 
- Loại gọi (IDD,STD,....) : cập nhật giá cho những mã cùng loại gọi  
- XXXXXXX -YYYYYYYY : c ập nhật giá cho các mã từ XXXXXXXX t ới 

YYYYYYYY 
- Operator : chọn nhà khai thác VNPT, Vietel, VDC, SGPostel 
- Tên vùng : Tên của vùng cước. Nếu bạn muốn thêm vùng mới, bạn vào tên 

vùng mới, chương trình sẽ thêm một vùng mới 
- Lễ             : Giá cước ngày lễ của hướng gọi này. 
- Chủ nhật   : Giá cước ngày chủ nhật của hướng gọi này. 
- Ngày thường :  Giá cước ngày thường của hướng gọi này. 

 
Sửa giá hướng gọi: nhấn nút Sửa . 
Thêm hướng gọi   : nhấn nút 'Thêm'  
Ví dụ :  

Bạn quay số "00689XXXXX" trong thứ hai tới thứ sáu : mã "00689"  là 
FRENCH POLYNESI 
Nếu bạn gọi sau 23 giờ hay trước 7 giờ : giá phút đầu là 1.84 Usd và các block 
kế tiếp (6 giây) là 0.18 Usd 
Nếu bạn gọi từ 7 giờ tới 23 giờ : giá phút đầu là 2.30 Usd và các block kế tiếp 
(6 giây) là 0.23 Usd 

 
 

 
 

4.3. Khai báo trung kế nối vào đường ADSL: 
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Bước 1: Vào File->Cost telephone->List trunk 
 

 
 

Nhấn nút Add để thêm trung kế: 
IDTK :  Số ID của trung kế mà chương trình nhận được. 
Name:  Tên trung kế. 
Sub digit: Số con số của số gọi đi trên Trung kế này sẽ bị bỏ bớt. 
Add digit: Chuổi số sẽ được thêm vào đầu số gọi đi sau khi đã trừ. 
Remark: Chứa chuổi phân tích trước theo đầu số quay. 
 dạng: XXX.../S/AAA...,XXX.../S/AAA...,…. 
  XXX… : đầu số của số gọi cần xử lý. 
  S : số con số đầu của số gọi bị bỏ. 
  AAA… : chuổi số được thêm vào đầu số bị gọi. 
 
Ví dụ: khi khai báo giống như trên và số gọi trên trung kế 001 là 01123456789, 
chương trình sẽ phân tích và lưu vào dữ liệu số bị gọi là :  
 Sau khi phân tích remark sẽ thành 023456789 (bỏ 3 số và thêm 0). 
 Sau phân tích chính sẽ là A456789 (bỏ 3 con thêm chử A). Chương trình sẽ lưu 
số này. 
 
Bước 2: Vào File->Cost telephone->Operator. 
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Khai báo dòng ADSL như trên. Khi tính cước chương trình sẽ thấy cuộc gọi bắt đầu 
bằng A sẽ biết là cuộc gọi qua ADSL. Chương trình sẽ trừ và thêm số (như trên sẽ bỏ 
chử A) và sau đó vào bảng hướng gọi để tìm hướng và tính tiền ứng với operator là 
ADSL. 
 
Bước 3 khai báo giá cước:  Vào File->Cost telephone->Table dial code 
 

 
 

Ví dụ khai báo cho hướng Canada gọi qua ADSL như trên. Để thêm vùng cước mới thì 
nhấn modify, sau đó nơi name zone đánh tên vùng cước mới và Enter. 
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4.4. Danh sách đặc biệt: 
 
Danh sách số điện thoại của nhân viên, khách hàng, đối tác, số đặc biệt,… Hệ thống sẽ ghi 
nơi đến tương ứng với tên của số điện thoại này trên số liệu cước. Có thể thống kê riêng 
các cuộc gọi tới danh sách này. 
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4.5. Loại gọi: 
 
Khai báo tăng giá cho từng loại gọi, gộp nhóm loại gọi trên báo cáo tóm tắt, ghi số liệu lên 
server, in tức thời,… 
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5. Đặt thông số cho hệ thống : 
 
 

 
 
   Setting system parameter 
 

5.1. Trang thông số chung: 
 

 
 

1. Nhóm tăng giá default nếu không tìm thấy máy hay authoury code trên danh bạ. 
2. Khai báo số ngày xem số liệu củ trên màn hình chính. 
3. Khai báo có tính cước giảm giá theo ngày lễ và chủ nhật không. 
4. Khai báo có tính cước giảm giá theo giờ. 
5. Chọn bảng giá của tỉnh cần tính. 
6. Phụ trội : cho phép in phụ trội cho việc tính bill, khai báo số phút khoán,số tiền 

khoán,tiền / phút phụ trội. 
7. Khai báo loại tiền chính (loại tiền hệ thông sẽ qui về khi tinh) 
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5.2. Trang kêt nối server: 
 

 
 
 

5.3. Trang tổng đài: cài đặt các thông số liên quan tổng đài: 
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6. Tỉ giá: 
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7. Cài đặt cột thông tin cuộc gọi: 
 

 
 
 

 
 
Thứ tự: vị trí cột trên màn hình chính, bằng 0 là không hiện cột này. 
Chiều rộng: bề rộng cột trên màn hình chinh 
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8. Cài đặt thông số cổng kêt nối tổng đài: 
 

 
 

8.1. Qua cổng COM: 
 

 
 

8.2. Qua cổng TCP/IP: 
 

 
 

8.3. Qua FTP: 
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9. Danh bạ điện thoại: 
 

9.1. Danh bạ : 
 

 
 
 

 
 

 
- Bạn có thể thêm hay xoá phòng và nhân viên trong các bộ phận, tầng lầu bởi sử 

sụng thanh công cụ của danh bạ. 
- Bạn có thể di chuyển nhân viên hay bộ phận tới bộ phận hay công ty khác bởi 

nhận phím trái và di chuyển chuột trên bộ phận khác 
- Bạn có thể xoá nhân viên, mẫu tin bởi nhấn nút "DELETE" 
- Khi chọn nhóm con, ở góc dưới bên trái sẽ hiện số tiền đã khoán cho nhóm (ô 

trắng), tổng số tiền đã phân bố cho các máy trong nhóm và số máy trong nhóm (ô 
màu vàng). 

- Mỗi nhân viên hay phòng có những tin tức sau : 
1. Tên : tên của nhân viên hay khách 
2. Họ : họ của nhân viên hay khách 
3. Điện thoại : điện thoại của nhân viên hay khách 
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4. Authority : mã cho phép gọi ra. Chỉ ADMIN có thể sửa mã authority. Người 
dùng khác không thể nhìn thấy mã này. 

5. Ngày dùng : Ngày bắt đầu sử dụng. Nếu bạn là người dùng có mức thấp hơn 
ADMIN và chọn nhân viên hay phòng trong danh sách, bạn sẽ cập nhật ngày 
dùng cho toàn bộ các nhân viên và phòng được chọn 

6. Phụ trội : Nhóm phụ trội của nhân viên hay phòng (giá trị 1,2,3). Nhìn thông số 
hệ thống 

7. Nhóm tăng giá : Nhóm tăng giá của nhân viên hay phòng (giá trị 1,2,3,4) . 
Nhìn loại gọi 

8. In tức thời : Nhóm in tức thời (giá trị 1,2). Nhìn loại gọi 
9. Nhóm in server : Nhóm ghi server (giá trị 1,2) . Nhìn loại gọi 
10. Loại : nhìn bảng loại phòng 
11. Trạng thái : nhìn bảng loại trạng thái phòng 

- Authority, Phụ trội, Nhóm tăng giá, In tức thời, chỉ được ghi và thay đổi bởi 
ADMIN. 
 

9.2. Tự động cập nhật danh bạ nội bộ: 
 

Khi chương trình nhận cước từ tổng đài sẽ tính cước và đồng thời kiểm tra 
máy này đã có trong danh bạ chưa. Nếu chưa có, chương trình sẽ tự động thêm 
vào danh bạ nội bộ như sau: 

 
- Cuộc gọi dùng mã: thêm vào danh bạ máy mới có số điện thoại là 999 và mã 

là mã vừa nhận, tên là “không tên”. 
- Cuộc gọi không dùng mã: thêm vào danh bạ máy mới có số điện thoại vừa 

nhận và mã là trống, tên là “không tên”. 
 

Máy mới được thêm vào nhóm đầu tiên trong danh bạ nếu version Office 
(Nhóm Technical), vào nhóm thứ hai nếu là version Hotel (Floor 1). 
Bạn có thể vào File -> Danh bạnội bộ để khai báo lại tên và số điện thoại, di 
chuyển máy này sang nhóm khác dùng thao tác kéo thả. 

 

 
 
Để hệ thống tự động thêm vào danh bạ nội bộ thì phải cho phép trong mục  
“Thêm danh bạ tự động” (Bạn vào Cài đặt -> Thông số hệ thống) 
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9.3. Khai báo địa chỉ email và nhóm báo cáo qua email: 
 

Bạn vào danh bạ nội bộ và khai báo chi tiết cho một máy như sau: 
 
- Nơi mục mail bạn sẽ vào nhóm mail và địa chỉ email của máy này.  
- Tùy theo đặc tính của nhóm mail mà chương trình sẽ gởi mail các cuộc gọi 

tức thời 
- Khai báo có báo cáo tự động hàng tháng cho chủ máy này qua email. 
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10. In hoá đơn chi tiết theo máy điện thoại, Account code, group, Trung kế : 
 

 
 

10.1. Theo máy nhánh: 
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10.2. Theo trung kế: 
 

 
 

10.3. Theo thống kê : 
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10.4. Theo nhóm: 
 

Chọn máy hay nhóm in 
 

 
 

 
 
 

1- Vào Extention/Trung kế cần in : cho các số máy cần in, điện thoại cách nhau bằng 
dấu phẩy, hay một dải máy bằng cách đánh số máy đầu và máy kết thúc cách nhau 
bằng dấu gạch nối ngang. Nếu để trống là in tất cả các máy. Ví dụ : 123,234-237,111 
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2- Số máy bị gọi : chỉ in các cuộc gọi tới một số máy , một hướng gọi ( Vào các số đầu 
của hướng gọi), các số bị gọi cách nhau bằng dấu phẩy. Ví dụ : 0078,1710082 để in 
các cuộc gọi đi Cà Mau và Korea dùng 171 
3- Chọn loại kết xuất: 
- Máy in : xuất ra máy in hay xem trên màn hình dưới dạng bill chi tiết, tóm tắt 
- HTML : xuat ra file HTML 
- File DBF : xuat ra file DBF 
- File Exel : xuat ra file Excel 
4- Chọn loại cuộc gọi cần in bằng cách nhấp chuột trái 2 lần trên loại cuộc gọi cần in 
(List bên trái),chọn tất cả bằng cách nhấn nút '>>', xoá list chọn bắng cách nhấn nút 
'<<'. 
5- Vào ngày giờ bắt đầu xử lý 
6- Vào ngày giờ kết thúc xử lý 
7- Chọn các chức năng 
        - Chọn option Authority code : nếu bạn muốn in những cuộc gọi của máy điện 
thoại cùng với các cuộc gọi ở các máy điện thoại khác có sử dụng mã authority của 
máy điện thoại này. 
        - Tính lại cước: Cước các cuộc gọi được tính lại trước khi in. 
        - VAT ở tổng : VAT sẽ được tính ở cuối hoá đơn. Vat không tính ở mỗi cuộc gọi. 
        - Sử dụng phụ trội: Các cuộc gọi mà có nhóm in là 0, sẽ được tính theo phụ trội. 
        - USD - VND : Tính USD và VND được in riêng biệt, sau đó tổng USD được đổi 
sang VND với tỉ giá USD của ngày in và tổng cộng bằng VND. Nếu bạn không chọn, 
Các cuộc gọi được tính bằng USD sẽ được đổi sang VND với tỉ giá ở thời điểm gọi. 
        - Tên nhóm : In tên nhóm và bô phận của mỗi máy. 
- In chi tiết : In hoá đơn chi tiết điện thoại 
- In tóm tắt phút : In tổng phút của mỗi loại gọi 
- In tóm tắt từng máy : In tổng cước mỗi loại gọi cho mỗi máy, nhân viên 
- In tóm tắt tất cả :In tổng cước mỗi loại gọi cho mỗi nhóm 
- Sắp thứ tự theo số bị gọi : In báo cáo theo thứ tự số bị gọi 
8 - Nhấn nút file cho chọn tên file xuất 
9 - VND >= : if  > 0 cho lọc những cuộc gọi có giá lớn hơn 
10- USD >= : if  > 0  lọc những cuộc gọi có giá lớn hơn 
11- VND = : if  > 0 cho cân đối với giá VND nhận từ hoá đơn của Bưu điện 
12- USD = : if  > 0 cho cân đối với giá USD nhận từ hoá đơn của Bưu điện 
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Hoá đơn  điện thoại chi tiết : 
 

 
 
Hoá đơn điện thoại tóm tắt : 
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Hoá đơn điện thoại tóm tắt theo nhóm: 
 

 
 
Báo cáo vượt định mức: 
  
Khi in báo cáo có chọn cờ Check norm sẽ xuất ra báo cáo có xét định mức. Màu xanh là chưa 
vượt, màu đỏ là vượt. 
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11. Sửa dạng báo cáo: 
 
Có thể sửa các dòng text trên các báo cáo theo ý muốn: 
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12. Tạo invoice cho khách và nhân viên: 
 

Khi khách trả phòng hay in danh sách hoá đơn cước cuối tháng cho khách hay nhân 
viên thì hệ thống sẽ tạo invoice cho mỗi hoá đơn. 
 

 
 
Khi cần in lại chỉ cần vào mục in invoice để chọn hoá đơn để in lại 
 

 
 

Hoá đơn in ra sẽ có đúng các cuộc gọi đã in lúc tạo invoice cùng với tên khách, ngày 
giờ ở mà chúng ta không cần phải nhớ. 
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13. Báo cáo dạng đồ thị: 
 

 
 
 
Trong các báo cáo chọn loại kết xuất là Đồ thị (Graph) thì kết quả sẽ kết xuất dưới dạng 
đồ thị như các hình sau: 
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14. Tính lại cước: 
 
Để tính lại cươc cho một khoảng thời gian, của các máy và hướng gọi. 
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15. Danh sách tổng hợp cuộc gọi cho các máy: 
 
15.1. Tổng cuộc gọi: 

Bạn vào menu và chọn mục “Tổng cuộc gọi” hay nhấn nút  để mở cửa sổ này: 
 

 
 
 
 

 
 

Trong cửa sổ này, nhấn nút  để xoá các số liệu tổng cộng nếu cần. 
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Mục ngày là ngày bắt đầu thống kê. Nếu bạn sửa lại ngày thì chương trình sẽ tính lại 
số liệu tổng của từng máy tính từ thời điểm này tới ngày hôm nay (nếu ngày báo cáo 
tháng trong thông số mail lớn hơn ngày hôm nay. 
Khi bạn thao tác check in một máy thì số liệu tổng của máy trong danh sách sẽ xoá về 
không. 
Mỗi khi nhận một cuộc gọi từ tổng đài, CDR xử lý tính cước và cập nhật công thêm số 
tiền của cuộc gọi vào danh sách này. Sau đó, xét định mức có vượt chưa sẽ mail cảnh 
báo cho người gọi. 
Nhập ngày bắt đầu tính ở góc dưới bên trái, CDR sẽ tự động tính lại số tiền đã gọi của 
từng máy tính từ ngày được set. 
Nếu có tính lại cước trong khoản thời gian xét định mức thì phải chạy chức năng này. 
 

 
15.2. Báo cáo chọn từ danh bạ: 
 

Khi bạn báo cáo số liệu từ mục “Báo cáo máy nhánh” hay “Thống kê điện thoại”, bạn 

sẽ không cần nhớ danh sách tên của điện thoại. Đơn giản bạn nhấn vào nút  để chọn 
máy từ danh sách. 

 

 
 
Cửa sổ “Báo cáo máy nhánh” 
 

 
 
Cửa sổ  “Thống kê điện thoại” 
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- Máy nào muốn in thì bạn đánh dấu cờ P.  
- Nút “Chọn tất cả” để đánh dấu tất cả các máy. 
- Nút “Ngược lại” để đánh dấu các máy không đánh dấu, xoá các máy đang 

đánh dấu. 
- Nút “Có tiền” : đánh dấu các máy có gọi tính từ ngày bắt đầu thống kê. 
- Bạn muốn sort theo cột nào thì nhấn vào đầu cột đó. 
 

Chương trình ưu tiên xét trong danh sách trước rồi xét tiếp khai báo trong dòng “Máy 
nhánh” hay “Extension. 
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16. Khai báo thông số cho tác vụ mail: 
 
16.1. Cài đặt thông sô mail: 
Bạn vào Cài đặt -> Thông số hệ thống và chọn tab Mail 
 

 
 

1. Profile mail: Profile của user mail defaul trong Outlook Express. Chương trình 
sẽ sử dụng user này để gởi mail đi. 

 
2. ĐC mail báo cáo: Chương trình sẽ gởi tới địa chỉ mail này các cảnh báo của 

chương trình. 
 

3. ĐC mai báo cước: Chương trình sẽ gởi tới địa chỉ mail này các báo cáo cước 
định kỳ, các báo cáo cước hàng tháng của mỗi máy hay cước tức thời nếu máy 
này không có địa chỉ email riêng. 

 
4. Mail chạy: nếu chọn thì tác vụ mail sẽ hoạt động, nếu không chọn thì các tác 

vụ mail sẽ ngưng. 
 

5. Báo cáo (phút): thời gian gởi các báo cáo định kỳ. 
Chương trình sẽ gởi vào ĐC mai báo cước tổng số cuộc gọi và tổng tiền tính 
từ đầu ngày hay lúc bắt đầu chương trình đến thời điểm báo cáo hiện tại mà 
chương trình nhận được từ tổng đài. 
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6. Ngày báo cáo cước: Ngày mà mỗi tháng chương trình sẽ tự động tạo báo cáo 
cước cho mỗi máy của toàn bộ hệ thống và gởi mail cho từng máy (nếu máy 
chưa có hay không có địa chỉ email thì chương trình sẽ gởi vào ĐC mai báo 
cước). Số liệu sẽ tính từ ngày bắt đầu thống kê trên cửa sổ “Danh sách tổng 
hợp cuộc gọi cho các máy” đến ngày hôm qua. Sau khi gởi báo cáo xong 
chương trình sẽ lấy ngày này thay vào ngày bắt đầu thống kê trên cửa sổ 
“Danh sách tổng hợp cuộc gọi cho các máy” và tính lại danh sách này. Do đó 
tháng sau chương trình sẽ báo cáo số liệu tiếp theo. 
Tuỳ theo có khai báo ở mục danh bạ nội bộ là có báo cáo tháng tự động hay 
không thì chương trình sẽ gởi báo cáo. 
 

7. Tóm tắt: Nếu không chọn thì số liệu cước cho mỗi máy hàng tháng là  dạng 
chi tiết. 
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Nếu chọn thì số liệu cước cho mỗi máy hàng tháng là dạng tóm tắt. 
 

 
 
Sau khi chạy báo cáo tháng xong, chương trình sẽ gởi mail vào địa chỉ ĐC mai 
báo cước báo số báo cáo đã gởi 
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8. Loại nhóm mail: 
- Nhóm mail : Tên nhóm mail. Mỗi máy trong danh danh bạ sẽ ứng với 

một nhóm này. 
- Nói (giây): Nếu cuộc gọi có thời gian nói chuyện  lớn hơn cột này, thì 

chương trình sẽ gởi số liệu chi tiết cuộc gọi này tới địa chỉ mail của chủ 
cuộc gọi. Nếu cột này = 0 nghĩa là không xét thời gian nói chuyện. 

 

 
 

- Cước: Nếu cuộc gọi có cước lớn hơn cột này, thì chương trình sẽ gởi số 
liệu chi tiết cuộc gọi này tới địa chỉ mail của chủ cuộc gọi. Nếu cột này 
= 0 nghĩa là không xét cước cuộc gọi. 

 

 
 

- Tổng: Nếu tổng tiền cộng dồn các cuộc gọi lớn hơn cột này, thì chương 
trình sẽ gởi số liệu chi tiết cuộc gọi tới địa chỉ mail của chủ cuộc gọi. 
Nếu cột này = 0 nghĩa là không xét tổng cước cuộc gọi. 

- Mail mặc định: Nếu chủ máy không có địa chỉ mail riêng (khai báo 
trong danh bạ điện thoại) thì chương trình sẽ lấy địa chỉ này thay vào, 
nếu địa chỉ này trống sẽ lấy ĐC mai báo cước. 

- Loại gọi:  các cuộc gọi thuộc loại gọi này mới xét các điều kiện trên. Để 
trống là tất cả các cuộc gọi. 

 
16.2. Cách khai báo trong Outlook Express: 

Để chạy được chức năng mail, trên máy phải cài đặt Outlook Express. 
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1. Cài Outlook Express : 
Nếu trên máy chưa có OutLook Express. Vào Control panel, chọn Add and 
remove program, chọn Add/Remove Windows components, đánh dấu Outlook 
Express. Nhấn next và Windows sẽ cài Outlook Express 
 

 
 
2. Khai báo account mail defefault: 
Chạy Outlook Express và chọn Tools -> Account -> Mail và Add môt user account 
default (Server mail phải hỗ trợ POP 3 như Yahoo.com.vn, gmail.com,…) 
 
3. Khai báo option để chạy với chương trình: 
Chạy Outlook Express và chọn Tools ->Option  
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Set thời gian gởi mail tự động : khai báo số phút Outlook Express check and send mail 
trong thông số “Check for new messages every”. 
Chọn tab Send và bỏ đánh dấu Send message immediately và Save copy of send messages 
in the ‘Sent Items’ folder. 
 

 
 

Vào tab Sercurity và bỏ đánh dấu Warn me when other applicatios try to send mail as me. 
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Vào tab Read và chọn Font. Khai báo như sau: 
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17. Kết nối với hệ thống ghi âm: 
 

Hệ thống ghi âm sẽ được kết nối vào các đường trung kế của tổng đài và các cuộc gọi 
sẽ được ghi âm lại dưới dạng file âm thanh (file WAV,..) trên ổ cứng hay server. 
  Chương trình sẽ dựa và các thông tin trên số liệu cước để link cuộc gọi với file âm 
thanh của hệ thống ghi âm như sau: 

- ID của trung kế (gọi ra hay gọi vào) tương đương số port ghi âm kết nối 
trên trung kế. 

- Ngày và thời gian gọi tương đương ngày giờ bắt đầu ghi âm mỗi cuộc gọi 
(độ lệch có thể khai báo trên chương trình) 

- Số gọi ra hay số chủ gọi vào (hệ thống ghi âm có caller ID) để xác định file 
ghi âm chính xác. 

 
Tuỳ hệ thống ghi âm ghi có các cách lấy thông tin cuộc gọi khi ghi âm như sau: 

- Tên file các file ghi âm có đầy đủ thông tin: port ghi âm, cờ gọi ra hay vào, 
số gọi ra hay chủ gọi vào, ngày, giờ gọi. 

Ví dụ: hệ thống Voice soft tạo các tên file âm thanh như sau: 
 

01--A-0835119567---20090707140017.wav 
01--B-35119567---20090707135652.wav 

01: port ghi âm 
A: cuộc gọi vào – 0835119567 số chủ gọi vào 
B: cuộc gọi ra – 35119567 số gọi ra 
20090707140017: ngày 07/07/2009 lúc 14:00:17 
20090707135652: ngày 07/07/2009 lúc 13:56:52 

( định dạng YYYMMDDHHMMSS) 
 

- Tên file là tên riêng của hệ thống, không có thông tin cuộc gọi trên tên file. 
Phải kết nối vào database của hệ thống ghi âm để lấy các thông tin cuộc 
gọi: port ghi âm, cờ gọi ra hay vào, số gọi ra hay chủ gọi vào, ngày, giờ gọi 
và tên file âm thanh. 

 
1. Cài đặt thông số kết nối: 

 
Bạn vào Cài đặt -> Thông số hệ thống và chọn tab “kết nối ghi âm” 

 
- Directory:   chọn thư mục lưu trữ các file ghi âm. 
- Loại ghi âm: Loại hệ thống ghi âm 
- Giờ gọi lệch: lệch thời gian giữa hệ thống ghi âm và tổng đài. Chương 

trình sẽ tìm tất cả các file âm thanh có giờ bắt đầu sớm hơn hay trể hơn thời 
gian tổng đài số giây lệch này. 

- Xét số:  Có xét số gọi ra hay chủ gọi vào không. 
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Bảng danh sách: chứa lịch sữ sử dụng từng port ghi âm của hệ thống ghi âm, ngày 
của mỗi port phải theo thứ tự tăng dần. 
 

- Port: Số port của hê thống ghi âm. 
- Date: Ngày bắt đầu sử dụng port này để ghi âm cho trung kế hay 

extention. 
- Type: T: kết nối port ghi âm vào trung kế  

E: kết nối port ghi âm vào extention 
- Trk_ext: số ID của trung kế kết nối vào port ghi âm (nếu type = T). số 

máy nội bộ kết nối vào port ghi âm (nếu type = E). 
- Remark: Ghi chú. 
 
Theo thông tin ngày của cuộc gọi từ tổng đài, chương trình sẽ dò trong danh 
sách các port ghi âm có ngày sử dụng trước ngày này và gần ngày này nhất. 
 
Từ thông tin số ID trung kế và số extention của cuộc gọi, nếu có port nào phù 
hợp với số ID trung kế hay số extention sẽ là port đã ghi âm cuộc gọi này. 
 

  để hiện cửa sổ chọn thư mục lưu trữ các file ghi âm 

 sẽ cập nhật danh sách tên file ghi âm vào chương trình. 
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2. Nghe ghi âm trên màn hình chính: 
 

 
 
Trên màn hình chính chọn cuộc gọi cần nghe ghi âm và nhấn F9. 
 

1. Nếu cuộc gọi chưa xác định file âm thanh nào, chương trình sẽ tìm kiếm trong 
danh sách file ghi âm các file phù hợp nhất với cuộc gọi này (port tương ứng, 
ngày giờ gọi, số chủ gọi hay bị gọi) và hiện ra danh sách để chúng ta chọn. 

2. Khi chọn nghe từng file này, nếu file nào đúng thì ta sẽ chọn file này để lưu số 
liệu. 
 

 
 

3. Nếu cuộc gọi đã xác định file ghi âm đúng (qua cách thực hiện trên), chương 
trình sẽ mở file ghi âm này và phát. 
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3. Nghe ghi âm cuộc gọi sau khi tìm kiếm cuộc gọi: 
 

 
 
Vào mục Điện thoại -> Ghép file ghi âm và cuộc gọi. 
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Vào các thông tin để tìm kiếm các cuộc gọi cần nghe âm thanh và nhấn nút  để thực 
hiện. Nếu có số liệu thì các cuộc gọi sẽ được liệt kê ra. 

Chọn cuộc gọi cần nghe âm thanh và nhấn nút: 
 

 để nghe âm thanh: 
- Nếu cuộc gọi đã xác định file ghi âm thì phát âm file này. 
- Nếu cuộc gọi chưa xác định file ghi âm thì chương trình sẽ tìm kiếm trong 

danh sách file ghi âm các file phù hợp nhất với cuộc gọi này (port tương 
ứng, ngày giờ gọi, số chủ gọi hay bị gọi) và hiện ra danh sách để chúng ta 
chọn. 

 

 để tìm kiếm trong danh sách file ghi âm các file phù hợp nhất với cuộc gọi này. 
Mặc dù cuộc gọi đã xác định file ghi âm nhưng chương trình vẫn thực hiện tìm kiếm 
trong danh sách file ghi âm các file phù hợp nhất với cuộc gọi để thay thế file đã tồn 
tại. Điều này cần thiết vì có thể lúc chọn file ghi âm lúc trước chúng ta đã bị sai. 
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18. Registry chương trình: 
 

Chương trình có 3 key 
 

18.1. Key demo: 
 

Vào menu Help->About software và nhập key demo trong file serial.txt sau đó 
nhấn nút registry. Chương trình sẽ hỏi số ngày chạy demo. 

 
18.2. Key chính thức cho bất kỳ PC nào: 

 
Vào menu Help->About software, nhập key và nhấn nút registry 

 

 
 

18.3. Key chính thức cho 1 PC: 
 

Gởi mã số ID PC cho nhà cung cấp, sẽ được cấp 1 key chạy chính thức cho 
máy PC được cài. 
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19. Giúp đở: 
 

Chương trình được thiết kế giúp đở động, ở  bất kỳ cửa sổ nào khi nhấn nút giúp đở, hệ 
thống sẽ thể hiện màn hình giúp đở cho cửa sổ đó. 
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20. Bảo mật: 
 

20.1. Logon hệ thông: 
 

Hệ thống có chức năng phân quyền theo 4 mức, khi truy cập phải nhập mã người 
dùng và password. Tuỳ theo mức được cấp mà có thể truy cập chức năng menu nào. 
 
Ví dụ khi logon với người dùng là OPERATER thì menu sẽ bị khoá một số chức 
năng: 
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20.2. Tạo người dùng mới: 
 

Quyền ADMIN  sẽ  được phép tạo người dùng mới và mưc mơi 
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21. Lưu trử dữ liệu cước: 
 

21.1. Backup dữ liệu: 
 

 
 
 

 
 

21.2. Load dữ liệu backup: 
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22. Các chức năng PMS: (Sử dụng cho các loại tổng đài có chức năng PMS): 
 

22.1. Chức năng: 
 
- Checkin :  Sau khi làm thủ tục checkin tại máy tính tiếp tân thì tên, họ, 

ngôn ngữ, mức giới hạn gọi ra sẽ được máy PMS lấy thông tin trên 
server gởi vào tổng đài . Máy của phòng sẽ được mở cho phép gọi và 
tên khách sẽ được hiện trên console khi gọi hay nhận cuộc gọi từ máy 
phòng đó. 

 
- Checkout : Sau khi làm thủ tục checkout tại máy tính tiếp tân,  máy 

PMS lấy thông tin trên server gởi vào tổng đài . Máy của phòng sẽ 
được khoá lại, và xóa tên khách khỏi máy. 

 
- Giới hạn mức gọi ra : từ máy mạng có thể cho phép máy trên phòng 

được gọi hay cấm gọi quốc tế, đường dài, thành phố v.v.. 
 

- Trạng thái phòng : khi có thay đổi trạng thái phòng từ máy điện thoại 
trên phòng, console thì thông tin đó sẽ được tổng đài gởi tới hệ thống 
PMS để ghi thông tin lên mạng. Code status: 0: Cleaned, 1: Dirty, 
2:Occup clean, 3: Occup dirty, 4: Repair 

 
- Báo thức : từ máy tính mạng có thể đặt giờ báo thức cho khách. (Tổng 

đài Avaya không có chức năng báo thức qua PMS) 
 

- Mini bar : từ máy  trên phòng trực buồng có thể bấm mã để gởi thông 
tin về mạng các thức uống khách đã dùng. 

  
 

22.2. Giao thức giửa chương trình font office và PMS & CDR: 
 
Giao thức giữa hai bên sẽ được dùng là các file DBF, Access, SQL hoặc TXT : 

 
- File PMS server send : các thông tin từ mạng muốn gởi cho tổng đài 

như checkin, checkout, báo thức, barin v.v... 
-  File PMS server : các thông tin từ tổng đài muốn gởi cho mạng như 

trạng thái phòng, mini bar. 
- File CDR : các số liệu cước cuộc gọi. 
- File WAKEUPSV: log các biến cố wakeup 
 
PMSSEND.DBF 
 

Lệnh Tel Cd_lenh Para1 Para2 Para3 
Check in   IN Name Langues  
Checkout  OU Name   
Add name  AN Name   
Unbar, Bar            UB 0 unbar, 1 bar               
Message waitting  MW 1:on, 0:off   
Wakeup set  WU YYMMDDHHMM         
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Wakeup cancel  WC    
Room status     RS Code status   

 
PMSSV.DBF 
 

Lệnh Room Status Ghi chu   
Room status     RS Code status   
Mini bar  MB Thông tin   

 
WAKEUPSV.DBF 
 

Tel WC_DT WC_TIME  Status   
      

 
22.3. Thao tác trên chương trình PMS_CDR các chức năng PMS: 

 
Trên màn hình chính sẽ hiện trạng thái từng extension 
 

 
 
Nhấp đúp chuột trên biểu tượng phòng sẽ vào cửa sổ checkin hay checkout. 
 

Phòng có khách 

Phòng trống 
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Các chức năng khác thì sẽ vào menu PMS command: 
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Chọn chức năng và vào thông số tương ứng 
 

 
 
và gởi cho tổng đài. 
 
Cử a sổ set các yêu cầu cho phòng: 
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22.4. Xem Logfile báo thức: 
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23. Các chức năng khách sạn: 
 

23.1. Check in khách : Trên menu chọn mục “Khách sạn” và chọn mục “Check in” 
 
 

 
 

Nhập số liệu khách đến và dịch vụ 
 

Nhấn vào mục phòng sẽ có danh sách các phòng còn trống để nhập khách vào. 
Phòng sẽ chuyển sang trạng thái có khách, hoá đơn điện thoại sẽ tự động ghi 
vào cho khách khi khách gọi. 
 
Có chức năng chuyển phòng lẫn nhau hay đổi phòng: các chi phí, dịch vụ, tiền 
phòng sẽ được chuyển theo khách qua phòng mới mà không phải nhập lại. 
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23.2. Vào các chi phí khác cho khách ở : Trên menu chọn mục “Khách sạn” và 
chọn mục “Input bill” 

 

 
 

Nhấn  mục phòng sẽ có danh sách các phòng còn khách đang ở chọn phòng 
khách đang ở, màn hình sẽ hiện tất cả các hoá đơn của khách đang ở. 
Nhấn nút “Thêm” để thêm hoá đơn phát sinh cho các loại dịch vụ 
Nhấn nút “Sửa” để sửa hoá đơn đã vào cho các loại dịch vụ 

 
 

23.3. Check out khách : 
 

Kiểm tra hoá đơn và in hoá đơn cho khách đi. 
Nhấn vào mục phòng sẽ có danh sách các phòng còn khách đang ở chọn khách 
đi. 
Nút kiểm Hoá đơn : chỉ xem hoá đơn của khách nhưng khách chưa đi 
Nút khách đi : In hoá đơn của khách đi và lưu số liệu, chuyển phòng sang trạng 
thái trống 
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